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CHAPTER 1  
 
What is Genie?  
 

1.1 Introduction  

 
Genie is ideally suitable for a variety of industrial and domestic Automation 
applications. Genie is a miniature PLC (Programmable Logic Controller) 
designed to simplify the electrical wiring of intelligent solutions. Genie is very 
simple to implement, its flexibility and its high performance allow users to save 
significant amount of time and money.  
 
It is very compact and lightweight. It is mountable on a DIN rail and also can be 
base mounted by fixing two screws. Input-output and power connections can be 
made using the easily accessible terminals. A hinged cover is provided to protect 
keys and the LCD display from dust.  
 
For applications that require more input-outputs than those available on Genie, 
extension modules are available. Maximum three extension modules can be 
connected to each Genie.  
 
Genie has a built in serial interface for connecting it to a PC. A memory card is 
also available for program back up.  
 

Front Facia 
 

1.   Power Input  
2.   Graphical LCD 4 Lines 12 
      characters 
3.   Screw Terminal block for  
      Digital inputs. 
4.   Analog 0-10 Volt inputs (only  
      for G8DDT0) 
5.   Delete key. 
6.   ALT key Selection and  
      validation. 
7.   Arrow keys. 
8.   OK key:  
9.   Escape key. 
10. Interface for Memory card and 
      PC cable. 
11. Relay Outputs. 
12. Communication inputs.  



1.2 Features and Capabilities  
 
Connections  
 
Digital Inputs, Analog Inputs and Digital outputs can be wired to Genie. Along 
with the physical connections user can also use soft connections (special 
functions) like Counter, Timer, Time switch (clock), Auxiliary relays, analog 
comparators (only for the DC model), and soft text message blocks as a part of 
the program. All types of automation parameters are provided, so no extra device 
needs to be connected to Genie. Genie alone is sufficient for most of the 
automation and control applications.  
 
Enter program  
 
Genie program is nothing but a logical connection of Genie parameters like 
inputs, outputs, special functions etc. User can enter program with the keypad on 
Genie or he can make use of G-SOFT, which runs on a PC, and is much easier 
to use. The programs can be changed as per the application thus it provides 
more Flexibility, Versatility.  
 
Debugging  
 
While executing (running) the Programs on Genie, the programs and the 
parameters can be viewed at the run time. Some of the parameters can even be 
changed during the “run” (provided the run-time lock is not activated). Hence 
program development speed can be increased.  
 
Transfer  
 
Genie provides facility to transfer the programs in following ways.  
 
• PC>Device 
• Device< PC 
• Device > Card  
• Card > Device  
 

Programs can be transferred to PC or Memory card and saved. Thus no need 
to enter same program again and again.  
 
LC display  
 
4 X 12 lines LC display is provided on Genie. On LC display, the programs can 
be viewed and edited. At the run time input output status can be observed which 
helps in monitoring the application.  
 
 
 



Supply flexibility  
 
AC as well as DC models are available which operate on a wide voltage band. 
Select a proper model by referring to the Technical specifications.  
 

Connecting more number of inputs and outputs  
 
With the extension module number of inputs and outputs can be increased. 
Maximum three Extension Modules can be used with one Genie. So it is easy to 
configure the systems that require more I/Os.  
 
1.3 Overview of Genie Contacts  
 
 
Notation No. of contacts 

available 
in AC Model 
G7DDT8 

No. of contacts 
available 
in DC Model 
G8DDT8 

Description 

I 8 8 Digital inputs for Genie. Can be used as 
normally close as well as normally open. 

J 8 8 Digital inputs for Extension module A can be 
used as normally open as well as normally 
close 

K 8 8 Digital inputs for Extension module B can be 
used as normally open as well as normally 
close 

L 8 8 Digital inputs for Extension module C can be 
used as normally open as well as normally 
close 

Q 

 
4 4 Potential free output points for Genie.  

U 4 4 Potential free output points for Extension 
module A 

V 4 4 Potential free output points for Extension 
module B 

W 4 4 Potential free output points for Extension 
module C 

Z 4 4 Auxiliary input. Used as push buttons. 
Can be used as manual inputs. 

M 32 32 Auxiliary relays. 
Used to save intermediate results in ladder 

T 16 16 Timer function 
Can be used in four different modes. 
Trigger, Reset coils can be used for every 
timer  

C 16 16 Counter function 
Can be used in Up counting as well as down 
counting mode. Retentive is selectable. 
Count, Direction, Reset coils can be used for 
every counter 

 
  



 16 16 Time switch (clock) function 
Block can be programmed as required.   
Cannot be used as coil. 
 

A 0 12 Analog function  
Analog voltage V1-V8 (whichever is 
connected) can be used in the equation. 
Cannot be used as coil. 

P 16 16 Compare Function for counters. Can be used 
to compare values of two counters or a 
counter value with an absolute value. 
Cannot be used as coil. 

Lines 

 
250 250 Program length 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



CHAPTER 2  
 
Installation of Genie unit 
 
In order to increase the reliability of the system and extract maximum 
performance of its functions, this section describes the precautions for installation 
of the system. 
 

2.1 General Safety Requirements 
 

   Danger 
 
 •   Install a safety circuit external to the PLC that keeps the entire system safe 
even when there are problems with the external power supply or the PLC 
module, otherwise, trouble could result from erroneous output or operation. 
 
 •    Outside the PLC construct mechanical damage preventing interlock circuits 
such as emergency stop, protective circuits, upper/lower limit switches and 
interlocking forward/reverse operations 
 
 •   The output components of the PLC, regardless it is relay, transistor are 
possible to cause permanent ON or OFF and resulting in serious incident, thus 
protective additional external circuit or mechanisms are necessary for the output 
points with major safety consideration. 
 
 •    Do not touch the PLC‘s conductive parts while power is on. Doing so could 
result in a shock or malfunctioning of device. 
 

    Caution 
 
•     Do not bunch the control wires or communication cables with the main circuit 
or power lines. They should be installed 100 mm (4 inches) or more away from 
each other. Not doing so could result in noise coupling on communication 
signals. 
 
 •    Fluctuations or variations in the mains supply voltage should not exceed the 
tolerance thresholds stated in the technical characteristics, as they may cause 
operating failures. 
 
•     Communication cable should always be shielded twisted pair cable. 
 
•     Serial interface cable and memory card is provided to use only for Genie. 
 
•     Power off the device before connecting the communication cable and 
memory card. 



 
General Precautions during Wiring 
 
The precautions on the connection of power cables are described below. 
1) Power Supply Wiring 

  

 •     When there is lot of noise on the power lines it is advised to connect                                   
      isolation transformer to the power supply of the PLC. Though sufficient care   
      has been taken within the PLC. 

 
 •    While using the DC model, run the 24 VDC input line away from the 100 V     
      AC and 200 V AC lines. 
 
 2) Wiring of I/O 

 
  •    Run the input lines and output lines away from each other. 
  •    When the output lines cannot be run away from the power supply      
        lines or the input lines use batch-shielded cable and earth it. 
 
Summary of advice on installation  
 
•  Power down the device 
•  Take all necessary measures to avoid unwanted relay triggering.  
•  Check to ensure that no voltage is present.  
•  Make the necessary ground and short circuit connections. 
•  Always follow the instructions stated in this user's guide. 
•  Remember, only qualified personnel are authorized to implement the Genie.  
•  Automation and control devices must be installed so that they are protected             
   against any risk of involuntary actuation. 
•  It is essential to ensure that all control system connections meet applicable.  
   safety standards 
•  Fluctuations or variations in the mains supply voltage should not exceed the  
   tolerance thresholds stated in the technical characteristics, as they may cause. 
   operating failures and lead to potentially dangerous situations 
• Take care to meet the standards that apply to emergency stop systems in  
   order to avoid potentially dangerous situations. Ensure that releasing the  
   emergency stop system does not cause the automated system to suddenly  
   restart. 
• Take all necessary measures to ensure that an application interrupted by a 
   drop or a break in the supply voltage can continue correctly and also ensure.  
   that no dangerous states, no matter how brief, may occur. 
•  If extension module is connected then communication between Base and      
    Extension module should preferably be with shielded twisted pair cable. 
 
  

 
 



2.2 Electrical connections 
Connecting the 110-240 V AC model: G7DDT8 

 
 

Connecting 12-24 V DC Model: G8DDT8 

 

. 

Please Provide 

Fuse: 250mA  

In Series with the 

line terminal 

 

Please Provide 

Fuse: 500 mA     

In Series with the 

line terminal 

 



Connecting Extension Modules 
 

 

 

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



CHAPTER 3  
 
G-SOFT  
 
3.1 Introduction  
 

G-SOFT Ver.5.x is one of the accessories of Genie. It has to be installed on a PC 
and it simplifies the task of program development. Of course, user can enter, 
debug and run the programs directly on Genie, but G-SOFT will provide an easy 
way and more flexibility.  
 
G-SOFT 5.x provides following facilities.  
 
• Entering the program in two modes:  
• In Full screen mode  
• In Genie mode  
• Saving programs  
• Debugging the Programs.  
• Running the programs in Genie mode  
• Printing programs  
• Simulation: with Genie and only on PC  
• Transferring programs.  
 

3.2 Installing GSOFT 5.x on PC  
 
To install G-SOFT, the PC needs to have following configuration:  
• Color monitor with minimum resolution 1024 X 768  
• Processor: Pentium II and above OR Equivalent  
• Free Hard disk: minimum 20 MB  
• RAM: 32 MB  
• CD Drive for installation of G-SOFT  
 
Installation procedure:  
Auto Run facility is provided. Where PC’s don’t use Auto run 
 
Insert a CD in CD Drive.  
Go in the respective directory.  
Click on “Set up” on the CD.  
Software will get installed automatically. It will also place an icon on the desktop 
its own.  
 
You can start G-SOFT either from the desktop or from “Start – Programs – G-
SOFT Group— G-SOFT 5.x”.  
 
For removing G-SOFT from your PC use “Uninstall” from the “Start – Programs – 

 G-SOFT Group-Uninstall”.  
 



3.3 Features of G-SOFT 
 
 
Entering the Program: Ladder Logic is the basis for programming the 
application. G-SOFT provides a user-friendly interface wherein the user only has 
to select contact type and contact number and place it at proper place. Most of 
the time contacts will get connected automatically. User can enter comments for 
better readability and for reference later. 
 
Saving programs: G-SOFT allows user to save individual programs on the PC.  
 
Debugging: G-SOFT is very powerful in error handling. It displays a variety of 
errors at the time of program entry itself so that user can make corrections. 
 
Running the programs on PC: User can simulate the program on PC. User can 
use buttons provided on the screen to simulate the input connections. Scroll bar 
can be used to simulate Analog input. The actuation/ de-actuation of the relays 
can be monitored on the screen.  
 
Printing: User can take print outs of programs in two different formats.  
 
Simulation with Genie unit: User can connect Genie unit to PC using a serial 
cable and program can be run through PC. In this mode the PC acts as a master 
and the inputs are taken from Genie and outputs are sent to Genie unit (and the 
extension modules, if connected). This mode is useful in debugging the entire 
system since the actual I/Os are used. 
 
Transferring program: Programs can be transferred from PC to Device and vice 
versa using serial cable. This saves the program entering time on Genie. 
 
3.4 Special Functions 
 
In addition to the inputs and outputs Genie has five types of special functions: 
timers, counters, time switch (clock), compare counters and analog functions. 
Each special function has a specific notation and is associated with certain 
preset parameters which user must set at the time of entering the programs. 
 
 
3.4.1 Timers 
 

 
 
The Timer function is used to delay, prolong and control actions after a set period 
of time. It has a Reset input, a Trigger input and an output that indicates time-out.  



 
Notation 
 
There are 16 timers available in AC and DC models of 250 lines. Timers can be 
used as contact as well as coil. In Genie T stands for Timer and timer numbers 
are represented from 1 to 16. Thus T8 represents the eighth timer. We refer the 
value of the nth timer as Tn. 
 
Timer used as Contact  
 
. Normally open (Tn): In this type of contact TRUE value is valid. 
. Normally closed. (tn): In this type of contact FALSE value is valid. 
 
Timer used as Coil 
 
. Trigger Input (TTn): In timer functions trigger is required to start timer 
operation (Timer cycle).  
 
 . Reset Input (RTn): Reset input is used to reset the current Timer value to 
zero. The Trigger contact is disabled and the block is ready for a new timer cycle. 
     
Note: If Reset and trigger become true simultaneously then the relay is reset and 
the timer does not run. 
 
Timing  
 
Genie allows different timing ranges.  
 
S - Time value is specified in seconds  
           Maximum time is  999.9 S 
           Resolution:   100 ms 
 
M: S - Time value is specified in minutes: seconds 
            Maximum time is  99.59 M  
            Resolution:    1s 
 
H: M - Time value is specified in hours: minutes 
             Maximum time is  99.99 H   
             Resolution is  1min 
 
 
Note: If Time value = 0 and Trigger is given then unpredictable operation may 
take place, this condition is shown as Program Error during program entry. 
 
 



Locking: Genie provides facility to "Lock" the parameters. This means if a 
parameter is locked, user cannot change the values at the RUN time.  
In Unlocked mode, effect of changing the time value in "RUN" Mode is as follows: 
 
Case 1 
 
Time of timing relay is 000.0, trigger not received, and no reset 
 
Set time:     030.0 s 
Enter and store new time value:  020.0 s 
Result --- Relay switches at           020.0S after next trigger signal is received. 
 
Case 2 
  
Trigger input is given to Timer; no reset, time is running. 
Set time:                030.0 s 
Current Time:               010.0 s 
Enter and store new time value:     020.0S 
Result --- Relay switches at    020.0S  
 
Case 3 
 
Trigger input is given to Timer; time has already elapsed, reset not received. 
Set Time:     060.0 s 
Current Time:   060.0 s 
Enter and store new time value:  080.0 s 
Result: Timer output remains active, 080.0 s is used for next timer cycle. 
 
Timer Functions 
 
There are 4 types of Timer functions. Each type triggers a specific kind of 
operation used to handle all possible cases in an application.  
 
A:  On Delay Timer: After receiving the trigger signal, the relay contact operates 
after delay time (make contact closes / break contact opens after the delay). 
 
B:  OFF Delay Timer: After receiving the trigger signal, the relay contact 
operates immediately (make contact closes / break contact opens). It remains 
operated as long as the trigger input is present. The timer starts when it detects 
that the trigger input is removed. The relay contact then switches after the set 
time has expired (make contact opens / break contact closes). 
 
C:   Single Pulse Timer: After receiving the trigger signal, the make contact 
closes (or break contact opens) for the specified time, independently of trigger 
present or not. 
 



 
D: Symmetric/Asymmetric ON/OFF timer: The relay contact opens and closes 
for the set time duration (pulse generator). The specified time duration value may 
be symmetric or asymmetric. 
 
 
 
 

 
 

 

Application:  
 
Delay to start a conveyor belt after a delay to ensure that the sensor is already 
active before the conveyor belt starts moving.  
 

 
 



 
 

Application 
 
To ensure that motors, conveyor belts or ventilators etc.continue to function for a 
specified time after switching off the control signal.  
 

 
 

 

Application:  
Ringing School Bell for specified time. 
 
D: Symmetric/Asymmetric timer: 

 

 

 



Application: 

Flashing of warning lamps, decorative lighting etc. 
 

3.4.2 Counters 
 

      
 
The Counter function is used to count pulses.  It has one "Count" input that 
changes the counter value on each change from off-to-on. The "Direction" input 
is to select the UP / DOWN mode. Reset input to make the counter equal to zero 
in up counting mode and equal to preset value in down counting mode. 
Counters can be configured to be Retentive so that count can persist after power 
supply interruptions. 
 
Notation: There are 16 Counter functions available in both models.  
Counters can be used as contact as well as coil. In Genie Cn is written for nth 
counter. C stands for Counter and n is for counter number. Thus C7 represents 
seventh counter. 
 
Counter used as Contact: 
  
•    Normally open (C1 to C16): The contact is closed when the counter reaches       
     the preset value. 
•    Normally closed (c1 to c16): The contact is closed until the counter has  
     reached its preset value. 
 
Counter used as Coil: 
 
Count Input (CC1 to CC16): The count input is used for changing the counter 
value. Each time the coil is triggered, the counter increments or decrements by 1, 
depending on the counting direction. 
 
Representation example: I1----------CC1. 
 
Direction input (DC1 to DC16): Direction input decides counter mode, Up / 
Down. If this coil is active, the counter counts down. The counter counts up if this 
coil is not active or is not used in the program (unconnected). 
 
Representation example: I2----------DC1. 
 
Reset Input (RC1 to RC16): Reset input is used to reset the current counter 
value to zero in up counting mode and to set the counter to the preset value in 
the down counting mode.  
 
Representation example: I1-------------RC1 
 



Note: Both Count and direction inputs are required for down counting. 
 
Counter value: 
Genie allows maximum count value equal to 9999. 
 
Locking: If the parameters are locked then user cannot change the values at 
RUN time. If the counter value is unlocked then user can change the value at 
RUN time. 

 
3.4.3 Time Switch (Clock) 
  

         
 
 
The Time switch (Clock) function block is used to validate time slots during which 
actions can be performed. It acts just like a programmable weekly timer  
 
Notation: There are 16 Time switch (clock) functions available in both models. 
Time switch (clock) can be used only as contact. In Genie: 

n- is written for nth Time switch (clock).  
 stands for Time switch (clock) and n are for number. 

 Sixteenth Time switch (clock). 
 
Time switch (clock) used as Contact 
  



1. Normally open ( n): The contact is closed when the Clock is in an enabled 
period. 
2. Normally closed. (Lower case n): The contact is closed when the Clock is 
not in an enabled period. 
 
Time settings: 
 
Start Day - For the range, any valid start day (Sunday to Saturday) can be 
specified. 
 
End day - For the range, any valid end day (Sunday to Saturday) is specified. If 
only one day is to be chosen, this field can be left blank. 
 
Start Time - For the range, a start operating time (00:00 to 23:59) is specified. 
 
Stop Time - For the range, a stop operating time (00:00 to 23:59) is specified. 
 
Block Number - Sixteen blocks can be used, numbered from 1 to 16. This 
parameter cannot be changed in the screen shown above. It is chosen when the 
block is entered in the diagram line. 
 
Locking: If the parameters are locked then user cannot change the values at 
RUN time.  
 
 
Example 1   
Enter timing - Block 1 From Monday to Friday   On Time 6:30 Off time 9:30   
Block 2 from Monday to Friday On time 17:00 Off time 22:30 
 
Make A (1) B (2) 
---------------------------------------------------------------------------------------------------------  

     
   
 
 



3.4.4 Analog Compare: (Used only for G8DDT8) 
 
 

     
                      
 
The analog compare blocks can be used only with the following Genie model: 
G8DDT8. This product works on 12 to 24 V DC supply voltage. There are two 
analog inputs, marked as V1 and V2.  
  
Notation 
 
There are 12 Analog comparator blocks available. Analog compare can be used 
as contact only. "An" is referred to as the nth analog compare. The "A" stands for 
Analog compare and n is for analog-compare number. Thus A12 represents 
twelfth analog compare. 
 
Analog compare used as Contact  
 
.   Normally open (A1 to A12): In this type of contact TRUE value is valid. 
.   Normally closed (a1 to a12): In this type of contact FALSE value is valid. 
 
Analog voltage  
 
Analog voltage ranging from 0 to10 V DC can be given to each input: I7 and I8. 
Analog voltage of one input can be compared with either the voltage of the other 
input or with a reference voltage.  
 
Locking 
 
Genie provides facility to lock the parameters. If the parameters are locked then 
user cannot change the values at RUN time.  
 



Example 
 

 
A1 = V1 > 6V 
       
 
3.4.5 Compare Counter Block 
 

  
Compare counter block is provided to compare any counter value with any other 
counter value or with absolute value.  
This block can only be used as input only i.e. its position in the ladder diagram 
should be in the contact elements rather than coil elements. 
 
This block saves on the memory of the PLC and also helps increase the scan 
time and helps in utilizing the counter blocks provided more efficiently. 
 
The parameters for this function block can be entered or accessed when entering 
the contact that represents the compare counter input in the ladder diagram line. 
Also 'PARAMETER' menu can be used to access or change the preset values of 
the function block. 
 
Notation: There are 16 Compare Counter functions available in both models.  
This block can be used as contact. In Genie Pn is written for nth compare block. 
P stands for Compare Counter and n is for number. Thus P7 represents seventh 

compare block. 

 
 
 



Compare Block used as contact: 
  
•  Normally open (P1 to P16): The contact is closed when the compare counter    
   condition is satisfied. 
 
•    Normally closed (p1 to p16): The contact is closed when the compare counter  
    condition is not satisfied. 
 
3.4.6. Soft message block: 
 

 
 
Soft message block is provided so that text message can be displayed in RUN 
MODE when its input is triggered. 
   Click on "Properties" menu line from the pop up menu for a soft text message 
block, then this window will appear. This window allows displaying a text 
message with the run time property as well the preset value and current value of 
any of the special function block selected. 
 
With a 0 to 1 transition of the signal at input, the display outputs your configured 
message text in RUN mode. 
 
If several message text functions were triggered, the message with highest 
priority is displayed. This also implies that a new message text is only displayed if 
its priority is higher than that of previously enabled message texts. 
You can change between the display in RUN mode and message text by means 
of   arrow   buttons. 
 
Simulation Mode  
  
 In simulation mode, the message texts are displayed in a small window  
 

 
  
Description of function 
  
Notation: There are 16 soft messages available in both models 
Soft message can be used only as coil. 
In Genie “X” stands for soft message box and soft message box nos. are 
represented from 1 to 16. 
 



Message settings: 
 
When a message block is selected following window appears. 
 
 

 
 
To insert parameters of special function click on Insert embedded data 
following window appears 
 

 
 
Select the special function block, its no and data option for example timer has 
preset time & current time as the data option 
Press ok, settings will be saved in the soft message block. 
 
 Message is displayed when its condition is true. 
 User can enter upto 36 characters for each message text & messages are 
assigned priority in the ascending order from X1 to X16. 
 
 
 
 
 



 
3.4.7 Device Simulator 
 
This mode of G-SOFT, which can be activated through the options menu on the 
toolbar and then selecting Device Simulator, is very useful in understanding how 
the Genie works in stand-alone mode.  The user interface of device simulator is 
as shown in following figure. 
 

 
 

The PC depicts the genie layout of LCD display and the keyboard .All 
menus and commands are very similar to genie unit. In this mode user can 
perform all tasks like program entry, debug and execution. It does not require a 
physical connection to genie unit. All inputs and outputs are simulated on the PC.    

The device simulator gives the user, the feel of working with the device. 
This mode helps the user to learn to edit as well as run the program like the 
device. In this mode the ladder entered in the G-Soft will be picked up and will be 
shown on the device simulation mode. And vise versa the ladder entered in the 
device simulator mode can be viewed in the G-Soft. 

The program is entered in the same way as it is edited in the device. 
Editing in the device, sequence of screen as it appears in simulation mode is 
same as it appears on the device. The keys on the device are operated using the 
mouse and its function is same as in the device.  Inputs can be given and the 
output status, the parameters as it appears in the device can be seen. 
 



CHAPTER 4  
 
Genie in Full screen Mode  
 
4.1 Overview  
 
Double click on the G-SOFT icon on the desktop, Genie software main screen 
will appear. Program that was active in the previous session will be displayed on 
the screen. 
 
G-SOFT displays a variety of information along with the program. 
 
.  It displays File name and path on the top. 
 
.  It displays the menus provided by Genie software. 
 
.  User can select program display mode.  
     . Genie 
     . PLC ladder 
     . Electrical 
 
.  User can select program content windows. 
    . Program  
    . Parameter 
    . Comment 
 
.   Genie configuration is displayed according to the user selection. 
 
.   PC clock is displayed – G-SOFT uses PC clock for functions related to time. 
 
.    It shows program with comments. 
 
.    I/O Function selector window gives information about Extension module 
selection. It  also shows the available functions. It also shows the number of 
contacts available for a particular function if clicked on that function icon. 
      
  Program errors window displays errors in the program if any. 
 
 
 
 
 
 
 
 
 



G-SOFT in Full Screen Mode 
 

 
 
4.2 Description of various windows 
 
The “G-SOFT “uses three types of main Windows: 
 
•  The Window in which user can view, enter and edit the Program. User can set 
properties of contacts and of coils by right clicking on the respective box .The 
electrical connections can be made or removed by simply clicking the mouse on 
the connections  
 
•  The I/O Function Selector window, from which user can choose contact and 
coil types, numbers, and comments to each contact. 
 
•  The Program Errors window shows the errors in the program at the time of 
editing  
 



The I/O function selector and error windows can be removed or displayed 
through the "View" menu on the top line. 
 
Other important windows are: 
 
•   Pop up menu window:  
 
Click right the mouse on any contact or coil in the program. This window will 
appear near the mouse pointer tip. User can select: 
  
Contact or coil type 
Delete / connect contact 
Delete / insert line 
Properties if applicable 
 
•  Timer properties window:  
 
Click on "Properties" menu line from the pop up menu window for a timer then 
this window will appear. This window allows changing the properties of timer 
function. At the RUN time also, the user can upgrade the properties of timer 
function if the timer is not locked. 
 
•   Time switch (clock) properties window:  
 

Right Click on the Time switch (clock) and select "Properties" menu line from the 
pop up menu. This window will appear. This window allows changing the 
properties of Time switch (clock) function. At the RUN time also, the user can 
upgrade the timings if not locked. 
 

•  Counter properties window:   
 
Click on "Properties" menu line from the pop up menu for a counter, this window 
will appear. This window allows changing the properties of counter function. At 
RUN time also, the user can upgrade the settings if the counter is not locked. 
 
•  Compare Counter properties window:  
 
This window will appear only if G8DDT8 model is selected in the configuration. 
Click on "Properties" menu line from the pop up menu for the compare counter 
function. This window allows changing the properties of this function. At RUN 
time user can upgrade the properties if function is not locked. 
 
•  Analog properties window:  
 
This window will appear only if G8DDT8 model is selected in the configuration. 
Click on "Properties" menu line from the pop up menu for an analog function. 



This window allows changing the properties of analog function. At RUN time user 
can upgrade the properties if function is not locked. 
  
•   Edit print footer window:  
 
From "File" drop down menu select "Edit Print Footer". User can enter 
information about project name, author, date etc. This will be printed on every 
page of the program printout.  
 
•   Configuration window:  
 
Click on "Configuration" in the top line to activate this window.  User can select 
model type and extension modules from this window. Since the input-output 
configuration depends on the Genie model chosen, it is recommended that 
proper configuration should be chosen before starting any program entry.  
 
•   Transfer window:  
 
Click on the "Transfer" menu, this window will appear.  It shows serial 
communication (Com) ports available on your PC for transfer, default baud rate 
and serial communication settings. User can select direction of data transfer. 
 
•   Input output window:  
 
Click on the "Simulation - Only on PC" menu or on the "Simulation - with genie 
unit” get this window. The digital inputs used in Genie are available here as 
check boxes. Analog voltages are available as scroll bars. Outputs which are 
activated are shown as red. User can press RUN button to start the simulation. 
Stop button to halt the simulation and EXIT to stop simulation. 
 
•   Z-Keys window:  
 
Start simulation by pressing RUN. Then this window will appear. Z1 - Z4 keys 
represents Auxiliary input in Genie 
 
4.3 Entering programs 
 
Select File -> New menu from the menu bar to create a new program. 
A blank screen will appear. Now you can start entering the program. Ensure that 
you have chosen proper Genie configuration before starting the program entry. 
 
Choose contact type: 
 
Position the cursor at the place where you want to insert the contact by a left 
click with mouse. The position will get highlighted. Choose the required contact 
type and contact number from I/O function selector. Click on the required contact 



and contact number, which will be highlighted for a few seconds. The selected 
contact will appear at the position selected in the program. The selected contact 
number will be shown with a tick mark to indicate that it has been used in the 
program. You can right click on any of the contact to change its type and 
properties. 
 
Connecting inputs and outputs 
 
Each circuit connection runs from left to right. Please remember this when you 
interconnect contacts and relay coils. User can draw a circuit connection 
horizontally from left to right and vertically between adjacent circuit connections. 
An intersection of circuit connections represents an electrical connection. 
 
Horizontal connection: 
 
To make a horizontal connection, click on the horizontal dotted line in the 
connection box of the circuit. Or to make connection in contact box, press right 
button and select "Joining link". Generally when an output coil is placed in the 
fourth column, it gets horizontally connected automatically. 
 
Vertical connection:  
 
To make a vertical connection click on the vertical dotted line in the connection 
box of the circuit. Vertical connection represents OR connection. For deleting a 
connection just left click on the connection line. 
 
To delete a coil, Press right click on the connection you want to delete, and press 
Delete contact or delete coil. 
 
Inserting and deleting a whole line in the program 
 
Right click on the row above that you want to insert a line and select "Insert 
Line". Right click on the row that you want to delete and select "Line Delete". 
  
Specifying parameters: 
 
In the program-editing window, take mouse pointer to the required contact 
position. Right click of mouse and select "Properties". The properties window will 
appear in the program 
 
Adding readability to the program 
 

Writing comments adds readability. You can write comments for each program 
line. You can write a comment for each contact and coil. To do this, click on the 
connection number from the I/O function selector window and write comment.  
 
 



Example 
 
Go to the position contact 1, row 1 select the position by left clicking the mouse. 
Select "I" (input) connection from I/O selector window. A number of "I" type 
contacts will appear at the bottom. Select I1 by mouse. "I1" will get displayed at 
the selected Position, which is in the first row, and at contact 1 position. "I1" will 
get selection mark. Write comment to I1 as 'On switch'. 
 
Now click at the position coil - row 1. Select "Q: from I/O function selection and 
then select contact number "Q1" by clicking on it. Q1 will get displayed at the 
selected position and "Q1" will get a selection mark. Add comment to Q1 as 
'Lights' 
 
Both coil and connection will get automatically connected. Select "Q1" by a right 
click of mouse. Select "State change contactor" parameter. It is understood that 
when 'On switch' is ON Lights will be ON, giving better readability. 
 
4.4 Error Messages 
 
G- SOFT shows errors at the time of editing only. 
The errors can be seen in the Program Errors window. 
The window shows Err. No, Line no, Err. Location, Err. Description 
Errors displayed are listed below. 
 
1. Left connection missing 
2. Right connection missing 
3. UP Connection open or not required 
4. DOWN Connection open or not required 
5. Special function block should be defined, since it is used as a contact 
6. Coil is assigned more than once 
7. Coil is assigned in multiple ways 
8. Coil Set/ Reset Improper 
9. Counter must have Count input in Coil column 
10. Timer must have non-zero Preset Time 
11. Timer Trigger is used more than then once 
12. Timer Reset is used more than then once 
13. Counter - Count Input is used more than then once 
14. Counter - Reset is used more than then once 
15. Counter - Direction is used more than then once 
16. Extension Module should be selected in Configuration 
17. Text - Reset is used more than once 
18. Improper or missing Connection 
19. Analog functions are not permitted in this model 
20. The block of Time switch (clock) must have days defined. 
21. Preset value of counter must be non-zero. 
22. Check the ON-OFF timing of TIME SWITCH (CLOCK) 



 
4.5 Program simulation on PC 
 
In this type of simulation, a Genie unit is not required. The program will run on 
PC without the actual input-outputs. In this mode all inputs are available as check 
boxes. One can click on the box and make input ON or OFF. Similarly output can 
be seen on PC. Whenever output coil is in ON condition, it will show as RED 
circle.  
 
Run:    Press RUN to start simulation. 
 
Stop:  Acts to halt the program. One can change the properties in between. 
            If pressed RUN again program will start again. 
         
Exit:    When pressed Exit button Simulation will get terminated. To start  
            simulation one has to select “Simulation” again. All states of outputs and  
            special functions will get reset. 
 
 
If the input check box is checked then:  
 
•   It is a TRUE condition for normally open contact.  
•   It is a FALSE condition for normally closed contact. 
 
If the input check box is not checked then: 
 
•   It is a FALSE condition for normally open contact. 
•   It is a TRUE condition for normally closed contact 
 
Example -  
 
Assume that the program "I1 -- -- -- Q1" already entered. 
  
Select "Simulation - Only on PC" and then press the RUN button to start 
simulation.  
 
Click on "I1" check box, Q1 will become ON.  
Click on "I1" again, Q1 will become OFF.  
 
It indicates that when I1 switch is ON lights will glow. If I1 is OFF lights will be 
OFF. 
 
  
 
 
 



 
4.6 Simulation with Genie unit 
 
For simulation with Genie user has to connect a serial cable from PC to Genie. 
Input conditions are taken from Genie and shown on PC in the check boxes. 
Similarly whenever output is in ON or OFF condition as the result of program 
execution, it is shown on PC as well as relay on Genie will operate. In this mode 
the program in the Genie unit is ignored, and the one in the G-SOFT on PC will 
be running. Only the inputs are taken from Genie unit and outputs are directed to 
the Genie unit. 
  
One can connect physical inputs and outputs to Genie 
 
To simulate the program, Select Simulation->With Device menu or Press Ctrl + 
F5. 
 
It shows the available serial communication ports (COM ports). Select COM Port 
to which the Genie unit is connected with the serial cable.  
 
Inputs - outputs window will appear which will show the status of inputs and 
outputs of Genie. 
 
 
 4.7 Parameters of Special Functions  
 
When entering a Program, the function block parameters must be filled in. To set 
the function parameters right click with mouse on the contact or coil in the 
program edit window. The Property windows are displayed for: 
 
1. Timer function block  
2. Counter function block 
3. Time switch (clock) function block 
4. Analog Compare function block 
5. Compare Counter function block 
 
Timer function properties  
 
1. Indication whether the timer is used in the program.  
2. Timer lock status 
3. Preset timing 
4. Inputs: Trigger and Reset, whether these are used as coils and will receive a  
    signal. 
5. Comment 
6. Timer function. 
7. You can select any other timer for viewing the properties. 
 



Counter function block 
 
1. Indication whether the counter is used in the program. 
2. Counter lock status 
3. Preset counter value 
4. Inputs: Count, Direction and Reset, if these are used as coils and receive a 
    signal. 
5. Retentivity selection. 
6. Comment 
 
Time switch (clock) function block 
  
1. Indication whether the Time switch (clock) is used in the program.  
2. Time switch (clock) lock status. 
3. Preset time. 
4. Comment 
5. It shows selected time slots graphically. 
 
Analog function block 
 
1. Indication whether the Analog Function is used in the program.  
2. Analog lock status. 
3. Analog function selection : comparator selection, reference voltage. 
4. Comment 
 
Compare Counter function Block 
 
1. Indication whether the Compare Function is used in the program.  
2. Compare lock status. 
3. Compare function selection: counter comparator input selection. 
4. Comment 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 
CHAPTER 5 
 
OTHER FEATURES OF G-SOFT 
 
5.1 Transferring data between PC and Genie unit 
 
Genie allows communication between the PC and "Genie”: 
 
PC to Genie 
 
1. Select Transfer->Program menu to display transfer dialog box. 
2. It will automatically detect the Serial ports available. You can connect a serial 
cable to any one port available.  
3. Press "PC>Device" button on transfer dialog box.  
4. Current program on the screen will get transferred to device. 
5. Transfer completion message "Transfer complete" will appear on the PC.  
 
Genie to PC 
 
1. Select Transfer->Program menu to display transfer dialog box. 
2. It will automatically detect the Serial ports available. You can connect a serial 
cable to any one port available.  
3. Press "Device>PC" button on transfer dialog box.  
4. Transfer completion message "Transfer complete" will appear on the PC.  
5. Read program will be shown on main screen. 
 
Device clock can also be transferred from "PC>Device”, "Device>PC" by just 
clicking on device clock in transfer menu. Clock settings can be read from device 
as well as be set. 
 
With the program the extension modules selected is also transferred the PC to 
Device as well as from Device to PC 
 
When a program is transferred even the extension modules selected are 
transferred. 
 
Transfer device utilities: 
Through device utilities password as well as backlight mode can be transferred 
from PC to Device. 
To transfer device utilities click on configuration menu on the toolbar & select  
 
 
 
 
 



 
Device Utilities, following window will appear. 
 

 
 
To transfer backlight mode, select the mode Auto, On or Off than click on the set 
mode button. 
“Backlight mode has been set successfully” message will appear on screen. 
 
To transfer password to the device click on set password, if device did not have 
password than following window will appear 
 

 
 
Enter New password , confirm the password again & press ok 
“Password has been set successfully” message will appear on the screen. 
 
If device already has a password and set password is selected following window 
will appear. 
 



 
 
Enter new password, confirm password and the old password than select ok 
“Password has been set successfully” message will be shown. 
 
 
Transfer device clock 
 
Device clock can be set as well as be read from the device 
 

 
 
5.2 Select Genie configuration 
 
Configuration allows selection of Genie model and Extension modules. Maximum 
three extension modules can be connected to one Genie. Extension modules of 
same type (AC or DC) can be connected. One can set the configuration as per 
the requirement. Each program can have different configuration. Configuration 
will get saved along with the program in the file. It will get automatically reloaded 
when a previously saved file is opened. Note that during "Simulation with Genie 



“" the configuration selected in G-Soft must match the actual configuration of 
Genie. 
 
5.3 Printing the programs  
 
Print outs can be taken using G-SOFT-5.x. 
It allows you to print program in details as well as in short. 
Click on "File" menu to see the printing options. 
 
Edit Print footer 
 
One can enter the print footer information.  
Information about the Project, version etc can be written. A provision is made to 
enter some additional information. File name and path and the page numbers will 
be automatically added to the footer.  
 
Print Short 
 
Print Short option prints the program in short. No comments will get displayed. It 
prints all 250 lines in a single page.  
 
Print Details 
 
Print details option prints the program in details. All comments will get displayed. 
10 lines will get printed on a single page. You will have choice of selecting a 
particular part of program for printing.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



CHAPTER 6 
 
Working With Genie 
 
6.1 Genie Editor Environment 
 

The block diagram below gives idea about the menu management interface and 
navigation to the functions available in Genie. 
--------------------------------------------------------------------------------------- 

 
 

Main menu Functions 
 
PROGRAM: Lets the user enter the Program that will make the Genie work. For 
information on how to enter programs, refer to the next section. This function 
may be password protected. 
 
RUN: Lets the user start program execution in either the RESET Mode or the 
CONTINUE Mode.  
 
 RESET Mode will reset all the previous states of Inputs/ Outputs, and will clear 
timer and counter states, and will start afresh.  
 
CONTINUE Mode will not change the previous states of the Inputs/ Outputs and 
special functions, and will continue the execution of the program. 
 



The PC AS MASTER Mode will be used while simulating the user program with 
device. 
 
PARAMETERS: This function lets the user display and change parameters of 
special functions like timer, counter, time switch (clock), compare counters and 
analog functions used in the program. This may be password protected and may 
have additional individual lock for each parameter. 
 
UTILITIES: This function lets the user set the clock and activate / deactivate 
Password facility, select the extension Module (A / B / C) and set the backlit 
configuration (ON/OFF/AUTO).  
 
SUB FUNCTIONS OF PROGRAM MENU 
 
EDIT:  EDIT function allows the user to enter a new program or edit an existing 
program. If Password is set, this function is accessible only with correct 
password. 
 
DELETE: This function will clear the entire program stored in the Genie .If 
password is set, this function will work only with correct password. 
  
TRANSFER: This function will transfer the program. 
Card >Device:   Loading from the memory card  
Device > Card:   Transfer to the memory card 
 
SUB FUNCTIONS OF UTILITIES 
 
SET CLOCK: This function is used to set the day and time: Day of the week, 
Hours-Minutes. This function is available only on Genie unit. In G-Soft you do not 
have this function, and the time/ day can be set on the PC using one of the 
Windows utilities. 
 
PASSWORD: This function allows setting or removing password. If password is 
set, certain functions like Program, Parameters are protected and are accessible 
only when correct password is entered. The Password can be set or removed; 
the status is indicated by the open or closed lock symbol. 
 
EXT. MOD:  This function allows the selection of the Extension Modules (A / B / 
C). Maximum 3 Extension Modules can be connected to the Genie Main Unit. In 
the G-Soft on PC, extension modules have to be chosen using the 
"Configuration" menu.  
 
 
BACKLIT CONF: This function allows the setting the backlit to either On, Off or 
be in the Auto mode. In the Auto mode, the backlit comes up only when a key is 



pressed on the device and remains for 10 seconds. If the ON or OFF modes are 
selected the backlit will be permanently ON or OFF respectively.  
The modes can be selected by pressing the UP or DOWN arrow keys on the 
device. 
To transfer these utilities from PC refer CHAPTER 5 Other Features of G-SOFT. 
 

6.1.1 Entering programs 
 
If you choose to enter or edit a program directly on Genie unit or in the Genie 
mode of G-Soft, you can select the "Edit" option from the "Program" submenu. 
 
Description of the keys 
 
The 8 keys located on the front of the Genie are used to configure, program and 
control the application. 
They perform the following actions.     
 
DEL Key: Press this key to delete a program element, or a blank line, if the 
cursor is located in the 1st (left most) column. 
 
ALT Key: Press this key for selecting/exiting any parameter in the edit mode and 
to show either the Parameters or Program while the program is running. This 
feature is useful for debugging. 
 
 
OK Key: Press this key to insert a program line, when cursor is blinking in the 
first column. During the parameter entry while editing this key saves the changes 
and proceeds to next parameter. In RUN mode, this key can be used to select 
one of the 3 displays. This also selects/deselects links.  
 
ESC Key: Press this key to exit the menu or a selection. During the parameter 
entry it proceeds to next parameter without saving the changes. 
 
ARROW keys: On the program editor screen, the arrow keys are used to move 
up, left, down and right. The position on screen is shown by a cursor or 
respective blinking text. 
On the parameter screen, left / right arrow moves the cursor to Next / previous 
position, and up / down keys increment / decrement the value. 
 
AUXILIARY Keys (Z-Keys): Arrow keys are called auxiliary keys in Run mode. 
They are used as push buttons to get signals from user. If user goes in PAR 
(parameter mode) or in PRG (program mode) in RUN mode, then these keys are 
not available as z-keys. At that time these keys are used as arrow keys.  
 
 
 



The format of Program is: 
 

• Maximum 250 lines of program 
• Each line will have up to 3 contact elements and one coil element. 
• Unless the contact is joined to previous or next line using the vertical joining      
   links, a coil is a must in every line.  
• Do not leave blank lines in the program, since this will unnecessarily increase  
   the length of the program but not hamper the execution time. 
 
 
 Entering a contact 
 
1 - Place the n blinking cursor in the required position. 
2 - Press ALT. 
3 - Choose the required element using the Up or Down keys. 
4 - Use the Right Arrow key to move to the number. 
5 - Choose the number using Up or Down keys. 
6 - Press ALT or Right Arrow to accept and to go to next position. 
 

 
 

Note: When the contact element is a special function, use ALT key rather than 
right arrow key to accept it. This will open a parameter display screen where you 
can enter various preset values. 
 

 



Entering a coil 
 

1 - Place the n blinking cursor in the required position. 
2 - Press ALT. 
3 - Choose the required element using the Up or Down keys. 
4 - Use the Right Arrow key to call-up the number. 
5 - Choose the number using Up or Down keys. 
6 - Use the Left Arrow key to move to the type of coil. 
7 - Choose the type of coil using Up or Down keys. 
8 - Press ALT or Right Arrow to accept and to go to next position. 

 

 
 

Entering the Joining Links  
To enter a link, proceed as follows. 
 
1 - Place the "  "  blinking cursor next to the desired location. 
2 - Press OK to start the link ("  " cursor). 
3 - Move the cursor to the desired location using the arrow keys. As the cursor  
      moves, the link is drawn. 
4 - Press OK to exit to normal mode. 
 
 
 



 
 

Repeat this action as many times as necessary to link all the elements together 
as required.  
 
Replacing a link with a contact 
 
To replace a link with a contact, simply place "  " cursor at the required location 
and press ALT to enter the contact as described on the previous page. 
 
Entering a new element 
 
In each line there are three possible positions of the blinking cursor , where a 
contact can be placed. A coil can be placed only in the right most column of each 
line 
 
Changing an element 
 
To change an element in an existing program, simply move to the element to 
change, press ALT and follow the same procedure as when entering a new 
element. 
 
Deleting an element 
 
To delete an element, simply place the    cursor on the required element, and 
then press Del. Generally, the deleted element must be replaced by a link. 
 
Deleting links between elements 
 
To delete a link, simply move the  cursor next to the desired position, press the 
OK key to change the cursor to -  and press Del. Key. This may delete some of 
the required connections, which may be restored by the same method as above. 



Deleting a program line 
 
Program lines are deleted lines by line. Proceed as follows: 
 
•  Move the cursor to the first column of the line, if necessary delete the elements  
   one by one to create blank line.  
•  Press Del. The line is deleted. 
 
Note: It is possible to delete the entire program stored in the Genie. To do this, 
call up the "DELETE" option in the Program menu and validate the deletion of all 
program lines. 
 
Inserting a program line 
 
To insert a program line, simply move   cursor to the first column of the line 
immediately above the one to create and press OK. 
 
Example 
By following the indications below, the user can enter the two-way switch 
program. 
 
Note: It is assumed that the password function is disabled.  
 
  • On the main screen move the cursor to "Program" and press OK button. 
 
  • Move the cursor to "Edit" and Press OK Button to select the editing mode. 
 
  • A blank screen appears and a blinking black box (cursor) is displayed.           
            Press ALT 
 
  • "I1" shown. "I" will blink. Genie prompts the user to select the type of  
              contact. 
 
  • Press Right Arrow. "1" will blink indicating selection a contact assigned to  
           digital input (I). Genie now prompts you to select the input number. 
 
  • Since we require "I1" as the first contact, press Right Arrow. The cursor           
           will blink 
              
  •  The? is moved ready to enter the second contact. 
 
  • Press ALT. The right hand "I" will blink. User prompted to select the type    
           of contact          
                    
  • Press Up arrow "i" will blink. You have just selected the reverse contact of  
            input I1. 



 
 • Press Right arrow, the "1" will blink. Now to change the input number 
            press Up  Arrow.  The "2" blinks. Now simply validate this selection. 
 
 • Press ALT or Right arrow. The cursor blinks. Move to the end of the line           
           ready to  enter the coil. 
 
 • Press Right arrow. The   blinks. Now enter the coil. 
 
 • Press ALT. The "Q" blinks. Now all that remains is to select the other  
           parameters for this coil.                      
 • Press ALT Key. The "1" blinks.  Coil "Q1" is validated. 
 
 • Press ALT Key. The coil is validated. The  cursor moves down to next      
           line and the links are displayed automatically. 
            
 •  Press ALT Key. The "I" located on the second line blinks 
 
 • Press Up Arrow to change the contact to "i". 
 
 • Press Right arrow. The 1 located on the second line blinks. 
 
 • Press Right Arrow. The cursor  blinks 
 
 • Press ALT. The I on the second line blinks 
 
 • Press right arrow. The 1 in the second line blinks. 
 
 • Press Up Arrow. The 2 in the second line blinks. 
 
 • Press Right arrow. The  cursor blinks. Now enter the link between the          
             two lines. 
  
 • Press OK. The  blinks. It indicates that it is now possible to set the link 
         between the two lines. 
 
 • Press Up arrow. The contact point blinks showing a   sign. Press OK key                
           to restore normal mode. 
 
 • Press ESC. The screen displays the menu as shown. The  blinks and the                                   
            ‘SAVE EXIT’ option is selected 
                         

 



           
 
•  Press ESC. The screen displays the main menu.   
 
• Press down Arrow. The Genie points to the RUN mode. The Genie can                   
             now be set to RUN 
 
•  Press OK. This will show the run-time screen. This screen allows the user  
           to view the inputs; outputs and functioning of the two-way switch (switch                   
           action, ON or  OFF, light ON or OFF).      
             
 
This simple application example demonstrates the user how to enter the 
program. The following points should be remembered: 
  
When a  blinks use the ALT button to add an element (contact or coil). When an 
element (I, Q, M etc.) blinks, it is possible to use the Up and Down arrow keys on 
the keypad to change the element. When the  blinks, the arrow keys can be 
used to draw the connecting links. To switch back to normal  cursor press OK 
Key. 
 
6.2 Run Function 
 
To RUN the program press Program -- Run from the main menu.  
 
The display will show: 
 
 
 

 
 
 

 
If Reset is selected  
Then all status of all outputs and function blocks will get reset. 
If Continue is pressed then program execution will proceed without changing 
either outputs or the current values of the function blocks. 
 
Genie unit has PC as master function in addition to Reset & Continue functions. 
This function used when Genie unit is used for simulation with G-SOFT. In this 
mode actual program is RUN from G-SOFT. Input & output conditions are taken 
from Genie unit. Serial cable needs to be connected between Genie unit & PC. 
 



User can press ALT key to show either the Parameters or Program while the 
program is running. This feature is useful for debugging. 
 
RUN Mode Display Screen (For G8DDT8) 
 

 
 

The screen shows:    
                      
1. Input status display  
2. Output status display 
3. Current day and time 
 
Note : When the Parameter or Program is displayed, Z-keys (Auxiliary keys) are 
not available as auxiliary keys. 
 
Parameter window in RUN mode: Press ESC. User can see the parameters of 
the special functions at RUN time. User can even change some of the parameter 
properties if the function is not locked.  Arrow-keys are used to change the 
parameter values if required. 
  

 
 

 

 

Program window in RUN mode: Press ESC. The above screen will be shown.  
User can see the program at RUN time. User cannot change the program. If the 
program elements are activated (the status is True), are shown in black 
background.  Only up and down arrow keys are used to go through the program. 
 
Note:  In Run mode extension module identities cannot be changed. 
   
6.3 Parameters of special functions on Genie 
 
When entering a Program, the function block parameters must be filled in. These 
parameter-setting screens are displayed for: 
 
Timer function block, 



Counter function block, 
Time Switch function block, 
Analog function block. 
Compare Counter function block. 
 
Regardless which screen is displayed, the parameter setting principle is the 
same. 
 
1 - Use the Right and Left arrow keys to move the  cursor onto the parameter to     
     be changed. 
2 - Place the cursor on the parameter to be changed, press Alt then use Up and 
     Down arrow keys to change the parameter value. 
3 - Finish data entry by pressing Esc (without saving the changes) or OK (after  
     saving the changes) then Esc key to return to program entry screen. 
4 - The parameters of all function blocks are accessible through the "Parameter"    
      form on the Main Menu also. 
 
Timer function block coils and parameters 
 
 
 
 

 
 
 

 

Note: When a "-[" is displayed in this screen, it indicates that the element was 
used in the program lines. This symbol will appear in the PARAMETER and RUN 
Menus. Place the cursor on the parameter to be changed, press ALT, and then 
use UP and DOWN keys to change the parameter values. 
 

Counter function block coils and parameters 
 
 
 

 
 
 

Counter direction input 

Block locking/unlocking 
Timer number 

Preset time unit 

Current time unit 
Reset input 
Type of timer 

Timer trigger 

Preset value 

Retentive selection (Y/N) 

Block locking/unlocking 
Counter input 

Reset input 



 

 

Note:  The parameters that can be changed are the preset value, lock and 
retentivity. Preset value is between 0 and 9999. 
When a "-["is displayed in this screen, it indicates that the element was used in 
the program. This symbol appears in the PARAMETER and RUN Menu. 
 

Time switch (clock) function block parameters 
 

 

 
 

 

 

 

 
 
 
Compare Counter function block parameters 
 

 
 

 

 
 

 

 

Example: 
 
       By following the indication below, the user can select Comparator for 
comparing counter C1 value with absolute value  
 
 
 

Counter C1 

On time 
Time 

Compare function 

Off time Block locking/unlocking 

Counter C2 

Block locking/unlocking 

Absolute value 
Compare function 
Counter C2 

Block locking/unlocking 



Edit Ladder as shown Below In The Device 
    

 
 

      

        Place the  cursor on P press ‘ALT’ 1 will blink again press ALT, screen as 
shown below will appear. 
 

 
 

    

 

     Bring the cursor at marked as 1 above and press ALT, then press Z4 key to 
select ABS, again press ALT. Bring the cursor at 0 by pressing Z3 key and enter 
the absolute value. Press ALT then OK to save the changes mode 
 

 
 
                   

Analog compare block parameters 

 

 
 

 
 
 

 

 

 
 

1 

Analog value 

Analog value 

Block locking/unlocking 



6.4 Password 
 
Password purpose 
 
The password secures access to the following main menu options: 
"PROGRAM-EDIT", "DELETE", "PARAMETERS" and "TRANSFER" The 
password comprises four numeric digits from 0 to 9. Therefore the password can 
have any value between 0 and 9999. The Password is entered as follows. 
 
Entering the password 
 
Select Password from UTILITIES menu. The  means that no password is set              
yet.  
Press Up Arrow. The 1 on the left blinks. Now enter the password 
Enter the password using the arrow keys The digit being changed blinks 
Press OK The password is activated and the user is returned to the utilities menu 
Password shows  next time 
 

Canceling password protection 
 
To cancel password protection, simply enter the current password (see above).  
The password is inhibited which is shown by the open lock symbol in the next 
password screen. 
 
Changing the password 
 
To change the password, simply cancel the former one and enter a new 
one (refer to the method described above). 
 
 

6.5 Transferring data to and from memory card 
 

Transferring data to memory card is useful when user wants to load the same 
program in many Genie units. In this case instead of using PC user can make 
use of memory card, which is capable of storing one program. This feature is 
particularly useful on the production line where user is not required to edit and 
debug the program and a PC is not available.  
 
Card > Genie 
 
This transfer is used to reload an application into the Genie. It avoids the need to 
re-enter an existing application.  
 
The following method is used: 
 
1.        Install the Memory card in the connector after removing the serial cable, if  
           present. 



2. Move cursor to the "TRANSFER" function from the "Program" menu. 
3. Press the OK key to validate. 
4. Select the Card > Device function. 
5. Press the OK key to validate. 
 
Note: Before transferring data to the Genie, use the DELETE command in the 
PROGRAM Menu to clear the contents of internal function blocks of the Genie. 
 
Device > Card  
 
The Genie has an optional EEPROM card. This function lets the user load the 
application from the Genie into the Memory Card. 
 
The following method is used: 
1.        Install the Memory card in the connector after removing the serial cable, if  
           present. 
2. Select the "TRANSFER" function from the "Program" menu. 
3. Press the OK key to validate. 
4. Select the Device > Card function. 
5. Press the OK key to validate. 
 
Caution: Do not remove the card during the data transfer to and from the 
card. Similarly avoid using Device>Card and Card>Device commands when 
a serial cable is connected to the Genie connector. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



CHAPTER 7 Extension Module Selection 
 
7.1 Module Terminology 
 
This section describes how extension module is selected. 
 
 

 
 
7.2 Extension Module Inputs and Outputs 
 

Ladder       diagram 
Representation        

Description Extension 
Module 
Product 
Code 
 

Identification 
on the 
product 

A B C  
I/P1-I/P6 J1-J6 K1-K6 L1-L6 Digital Inputs for 12-

24VDC Extension 
module 

G8DDT5E 

AN1&AN2 V3-V4 V5-V6 V7-V8 Analog Inputs for 12- 24 
VDC Extension module 

I/P1-1/P8 J1-J8 K1-K8 L1-L8 Digital Inputs for110-
240VAC  
Extension module 

G7DDT5D 

O/P1-O/P4 U1-U4 V1-V4 W1-W4 Digital outputs for 
24VDC, 110-240 VAC 
Extensions 

 
 
 

Notes: Analog inputs can also be used as digital inputs. 
As per the selection of extension modules, the ladder diagram should be      
entered for the Inputs and their respective outputs. 
In “Run” mode extension module identities cannot be changed. 
When two External power supplies are used, observe the connections of 
the Live and Neutral. They cannot be interchanged. 
Wire C1, C2 using twisted pair cable. 
In the event of an error in communication between base and extension 
module due to a noise or physical disconnection the base module will 
show an error number  
 



 

 
Chapter 8 
 
Technical Specification 
 
8.1 Electrical Specifications 
 
 G8DDT8 G7DDT8 
Digital Inputs 6(I1 –I6) 8(I1-I8) 
Weekly clock Yes Yes 
Supply Voltage(Ur) 12-24 V DC 110 -240 V AC 
Supply Variation -10% to +10% of Ur -20% to +10% of Ur 

Max Supply current 360 mA 36 mA AT 110 V AC 
Digital Input Voltage 
range 

0-4 V DC OFF(“0”) 
8-26.4 VDC ON(“1”) 

0-40 VAC OFF(“0”) 
80-265VAC ON(“1”) 

Max. Digital Input Current  0.5 mA 0.5 mA 
Relay outputs 4 4 
Analog inputs 2(0-10 VDC); could be 

used digitally 
- 

 
 
8.2 EMI/EMC Specifications 
 
The EMC directive specifies that products placed on the market must "be so 
constructed that they do not cause excessive electromagnetic interference 
(emissions) and are not unduly affected by electromagnetic interference 
(immunity)".  
 

 
 
Note: The tests for the above test items were done when PLC was installed 
in a conductive control panel. 



8.3 Genie Parameters Strength 
 

 
 
 
Note:  Analog Inputs can also be used as digital inputs 
 
 
 
 
 
 
 
 



8.4 Mechanical Dimensions 

 
 
 
Sample Programs 
 
Genie sample programs 
 
 Example 1  Watering of greenhouse plants  
 Example 2  Watering of roadside plants 
 Example 3  Bell system in a factory 
 Example 4  Roll down shutters 
 Example 5  Shop lighting 
 Example 6  Parking lot  
 Example 7  Cream stirrer in a dairy 
 Example 8  Exterior and Interior lighting 
 Example 9  Load Utilization 
 Example 10  Step switch - ventilator 
 
 Note: All programs are stored in directory 'sample programs' on PC. 
 
Example 1 
  
Genie used for WATERING OF ROADSIDE PLANTS 
 
Watering requirements 
 
A system is required to control the watering of road side plants such that the 
pedestrians have an option to walk on either side of road. 
Plants need water daily twice. 



In the morning from 6:00 to 6:03 side 1 and 6:10 to 6:13 side 2 
In the evening from 8:00 to 8:03 side 1 and 8:10 to 8:13 side 2 
 
 Genie Solution 
  
Genie to control watering. 
  
I1 - ON Switch 
Q1 - Solenoid valve for watering plant on one side 
Q2 - Solenoid valve for watering plant on the other side  

1- Time switch 1 from Mon. to Sun ON time 6:00 OFF time 6:03 
2- Time switch 2 from Mon. to Sun ON time 20:00 OFF time 20:03 
3- Time switch 1 from Mon. to Sun ON time 6:10 OFF time 6:13 
4- Time switch 2 from Mon. to Sun ON time 20:10 OFF time 20:13 

  
 
  
Example 2 
  
Genie used as WATERING OF GREENHOUSE PLANTS 
 
Greenhouse requirements 
 
There are two types of plants in green house. 
Type 1 - this type of plants need water every morning and evening for 3 minutes 
Type 2 - this type of plants need water every alternate evening 
  
Genie Solution 
 
Greenhouse wants Genie to control watering. 
 
 Genie uses  
I1 - ON Switch 
Q1 - Solenoid valve for watering plant type 1 
Q2 - Solenoid valve for watering plant type 2 

1- Timeswitch 1: From Mon. to Sun ON time 6:00 OFF time 6:02 
2- Timeswitch 2: From Mon. to Sun ON time 18:00 OFF time 18:02 
3- Timeswitch 3: from Mon. to Sun ON time 8:00 OFF time 8:02 

 
Example 3 
 
 Genie used as BELL SYSTEM e.g. IN FACTORY 
 
Factory activities  
 
From Mon. to Thu. Factory starts at 8:00 and ends at 16:30 



On Fri factory starts at 8:00 and ends at 15:30 
Breakfast time: Everyday from 9:45 to 10:00 
Lunch time: Everyday from 12:45 to 13:30 
  
Genie Solution 
Bell should ring 2 minutes each time 
  
 Genie uses  
 
I1 - ON Switch 
Q1 - Bell  

1- Timeswitch 1: from Mon. to Fri. ON time 8:00 OFF time 8:01 
2- Timeswitch 2: from Mon. to Fri. ON time 9:45 OFF time 9:46  
3- Timeswitch 3: from Mon. to Fri. ON time 10:00 OFF time 10:01 
4- Timeswitch 4: from Mon. to Fri. ON time 12:45 OFF time 12:46 
5- Timeswitch 5: from Mon to Thu. ON time 13:30 OFF time 13:31 
6- Timeswitch 6: from Mon to Thu ON time 16:30 OFF time 16:31 
7- Timeswitch 7: from Mon. to Fri ON time 13:30 OFF time 13:31 
8- Timeswitch 8: from Mon. to Fri ON time 15:30 OFF time 15:31 

  
Example 4  
  
Genie used as ROLL DOWN SHUTTERS CONTROLLER 
 
Requirements 
 
Opening and closing of shutters is to be controlled. 
There are two types of operations by which shutters can be controlled. 
Type 1 - Manual operation 
Type 2 - Automatic operation 
 
 Genie Solution 
  
Genie allows shutters to control manually as well as by Genie. 
If in manual operation mode, shutter will be opened whenever Shutter open key 
is pressed and shutter will be closed whenever shutter close key is pressed. 
In Automatic operation mode, Shutter will open only for time 7:00 AM to 6:00 PM 
Closing of shutters also depends upon photosensitive switch. 
  
Manual node and Automatic mode operation is decided by a switch. 
  
Genie uses  
 
I1 - Photo-Sensitive switch to detect sufficient light 
I2 - Manual switch to take shutter UP 
I3 - Manual switch to take shutter down 



I6 - Operation mode switch to select manual mode or automatic mode 
Q1 -Shutter Up 
Q2 -Shutter Close 

1 - To set timing for Shutter close 
         Block A from Mon. to Sun. ON time 7:00 OFF time 18:00 
 
Example 5 
 
Genie used for CONTROLLING SHOP LIGHTING 
 
Shop activities  
 
Shop is open from Monday to Friday from 8:00 AM to 10:00 evening. 
                          On Saturday from 8:00 to Midnight  
                          On Sunday Midday to 8:00 in the Evening. 
 
When Shop opens Regular lighting is turned ON. 
When sunlight is insufficient, additional light is turned ON. 
During nighttime when shop is closed minimum light is ON. 
To highlight some special items, whenever customer passes from special item 
window, spotlight turns ON. 
 
Genie Solution 
 
Shop has four types of lights. 
1. Lighting during the daytime. 
2. Additional lighting in the evening 
3. Minimum lighting during night. 
4. Spotlights to light particular articles. 
 
Genie uses  
 

I1 - Photosensitive switch to detect additional lighting requirement. 
I2 - ON Switch 
Z1- Test Switch: .to test all types of lights. 
I4 - Motion detector to decide spot light to turn ON 
Q1 - Lighting during day time 
Q2 - Additional lighting in the evening 
Q3 - Lighting during the night 
Q4 - Spot lights 
 

1 - Time switch (clock) used to set timing for which shop is open 
         Same Time switch (clock) is used for timing from Monday to Friday, 
Saturday and       
         Sunday. 

2 Timeswitch 1: from Mon. to Fri. ON time 8:00 OFF time 10:00  



3 Timeswitch 2: from Sat to Sat. ON time 8:00 OFF time 00:00 
4 Timeswitch 3: from Sun to Sun ON time 12:00 OFF time 18:00 

T1 - Timer is used to set time for which all lights are to be turn ON for testing 
purpose. 
       Timer is used in OFF delay mode Z1 is used to trigger the timer.  
T2 - Timer is used to set the timing for which spotlight to turn ON.  
        Timer is used in OFF delay mode. Motion detector is used to trigger the 
timer. 
  
Example 6  
 
Genie used for controlling parking lot 
 
Requirement 
 
Parking lot is available for certain time. 
Vehicles entering and exiting need to count 
Lights should be controlled as per he Vehicle entry and the pedestrian's access 
buttons. 
CO2 level in the parking lot should be monitored.  
Manual entries are permitted. 
  
Genie Solution 
 
Parking lot timings are from Mon. to Fri 8:30 AM to 5 PM and on Sat 9:30 Am to 
12 Noon 
Smoke detector is connected to detect CO2 level 
Pedestrian's access points are near the elevator so that they can put ON the 
lights when they come to take out the vehicle. 
 
 Genie uses  
 
Genie and Extension module A 
 
I1 - Vehicle entry  
I2 - Vehicle Exit 
I3 - Pedestrian's access point 
I4 - Pedestrian's access point 
Q1 - RED light to indicate parking lot Full 
Q2 - Green light to indicate parking lot is available 
Q3 - Parking lights 
Q4 - Exhaust Fan 
T1 - Timer used to set time for lights ON  
         T1 is used in  
T2 - Timer used to set time for Fan  
C1 - Counter to count number of vehicles. 



Z1 - Manual mode 
Z2 - Automatic mode 
Z3 - Manual Exit 
Z4 - Manual entry 
A1 - Equation for CO2 level. 

1 - Parking lot timing. 
 
Example 7 
 
Genie used to control CREAM STIRRER IN A DAIRY 
 
Requirement  
 
In a dairy a Cream Stirrer is continuously need to rotate. To control this, Genie is 
used.  
Genie should allow automatic control as well as direct / continuous operation.  
  
Genie Solution 
 
To select automatic operation or continuous operation a switch is used.  
In Continuous operation mode Stirrer runs continuously without interrupt where 
as in Automatic operating mode stirrer switches ON and OFF. 
ON for 15 Seconds and OFF for 10 seconds. 
Signal is given in case of any error or fault condition in the system. 
In case of fault, a fault indicator and alarm should get activated. Alarm gives 
sound in continuous on OFF mode unless fault is acknowledged. 
Acknowledgement signal is given to Genie. 
 
Genie uses  
 
I1 - Automatic / Continuous mode selector.  High - Automatic mode  
      Low - Continuous mode. 
I3 - Fault condition 
I4 - Acknowledgement for alarm only 
Q1 - Stirrer 
Q2 - Fault indicator 
Q3 - Alarm 
T1 - Timer for Stirrer ON (used in Pulse mode timer 15 Sec) 
T2 - Timer for Stirrer OFF (used in OFF delay mode Timer 10 Sec) 
T3 - Timer for Alarm beep of time 1 sec ON - OFF (used in Flashing mode) 
 
Example 8 
 
Genie used to CONTROL EXTERIOR AND INTERIOR LIGHT OF A HOUSE 
 
 



Requirement 
 
Lights should be controlled only in the evening. From 7:00 PM TO 5:00 AM in the 
morning.  
 
Whenever a person comes from any direction, Exterior light in the corresponding 
direction should become ON for specified time. Time is such that a person should 
be able to pass from there. Lights should be made ON only in the dark. 
For some cases user need to put ON all exterior lights, which is independent of 
time and darkness. 
 
In case of alarm input signal from buglers alarm system signal, all exterior as well 
as interior lights are ON along with buzzer.  
Buzzer is made continuous ON and OFF. 
  
Genie Solution 
 
Three motion detectors are connected in three directions.  
Another detector is connected which will make all exterior lights ON. 
 
Genie uses  
 
I1 - Photosensitive switch to detect darkness. 
I2 - Motion detector position 1 
I3 - Motion detector position 2 
I4 - Motion detector position 3 
I5 - Motion detector position 4 
I6 - Alarm Contact 
Q1 - Exterior lighting 1 
Q2 - Exterior lighting 1 
Q3 - Exterior lighting 1 
Q4 - Interior lighting  
T1 - Timer is used to set time for which Lights to be made ON in one direction 
 Timer use in OFF delay mode. I2 is used as trigger to this timer 
T2 - Timer is used to set time for which Lights to be made ON in second direction 
 Timer use in OFF delay mode. I3 is used as trigger to this timer 
T3 - Timer is used to set time for which Lights to be made ON in third direction 
 Timer use in OFF delay mode. I4 is used as trigger to this timer 
T4 - Timer is used to set time for which, all exterior lights to be made ON 
T5 - Timer is used to set time for which interior as well as exterior lights to be 
made ON 

1 - To set timing for which the motion detectors are sensed.  
 
 
 
 



Example 9 
 
Genie used for LOAD UTILIZATION: Switching a group of three similar loads 
   
Requirement 
 
An application needs two loads in operation. For less wear and tear three loads 
are used and two of them are to be used at a time so Genie is needed. To 
ensure equal wear and tear of the loads, they must be alternately switched ON 
and OFF. 
In case of fault condition at any one load, other two are continuously ON. 
 
 Genie Solution 
 
Two loads should be ON at a time. 
Genie will start with load 1 and 2 then it will switch to 2 and 3 and then 3 and 1. 
 
Genie uses  
 
I1 - Fault at load 1 
I2 - Fault at load 2 
I3 - Fault at load 3 
Q1 - Load 1 
Q2 - Load 2 
Q3 - Load 3 
Q4 - Fault indicator 
T1 - Timer is used to set time for which Load 1 and 2 will be in operation 
T2 - Timer is used to set time for which Load 2 and 3 will be in operation 
T3 - Timer is used to set time for which Load 3 and 1 will be in operation 
M4 - Dummy output used to get the start condition. 
  
Example 10 
 
Genie used for STEP SWITCHING e.g. VENTILATORS 
 
Requirement  
 
Genie used to switch between different levels of a ventilator. 
Four doors of a ventilator are to make ON or OFF step by step. The buttons 
connected decides whether to open the door or to close the door.  
While opening the doors, each door should open after certain time even tough 
button pressed twice at a time. 
  
 
 
 



Genie solution 
 
Button I1 starts the ventilator at level 1. If the button is pressed again, level 2 is 
opened that is one level up. Similarly, when another button I2 is pressed, 
ventilator closes the door one level down.  
  
 
 
Genie uses  
 
I1 - Button for upward direction 
I2 - Button for downward direction 
Q1 - Contactor level 1 
Q2 - Contactor level 2 
Q3 - Contactor level 3 
Q4 - Contactor level 4 
T1 - Timer is used to set minimum delay between level 1 and 2 opening 
T2 - Timer is used to set minimum delay between level 2 and 3 opening 
T3 - Timer is used to set minimum delay between level 3 and 4 opening 
C1 - Counter used to count number of levels opened before level 1 
C2 - Counter used to count number of levels opened before level 2 
C3 - Counter used to count number of levels opened before level 3 
C4 - Counter used to count number of levels opened before level 4 
 
Example 11  
 
Genie used in BATCH BOTTLE COUNTING 
 
Requirement  
 
In bottle counting applications, an indication is required if particular no. of bottles 
are counted. These indications are to be given at different times when some 
batch of bottles is completed. 
  
Genie Solution  
 
To count bottles, the sensor input, which counts the bottles, has to be given to 
Genie. 
Once the sensor input is given to Genie, the counting is carried according to the 
ladder. The counter value increments on every input sensed.  
The same counter is used to compare with three other counter values. If user 
wants to show some lamp indication if counting is over up to 1000, 3000 & 5000, 
then he just can compare those values in the compare counter block & make the 
corresponding output ON to show some indications. 
 
 



Genie uses  
 
I1 - Input for bottle counting. 
Q1 - Indication for 1st batch complete. 
Q2 - Indication for 2nd batch complete. 
Q3 - Indication for 3rd batch complete.  
C1 - Counter to count number of bottles. 
P1 - Compare Counter block to compare counter value to 1000 (Batch 1 
complete indication) 
P2 - Compare Counter block to compare counter value to 3000 (Batch 2 
complete indication) 
P3 - Compare Counter block to compare counter value to 5000 (Batch 3 
complete indication) 
 
 
 
 
 
 
 
 
 
 
FAQ 
 
Sr No Question Answer 
01 Does Genie support both AC 

and DC inputs? 
Separate modules fro AC(110 V to 
240V) and DC(12 to 24 V) inputs are 
available. Select a proper module 
referring to specification given.       

02 How many inputs and outputs 
can be connected? 

You can connect 8 inputs and 4 
digital/relay outputs to each of 
Genie’s base and expansion units (3 
extensions units at present). So, total 
32 inputs and 16 relay outputs 
altogether.    

03 Can I connect analog input to 
Genie? 

Yes, 2 analog inputs for DC operated 
module. The analog inputs are of 
voltage type with input range of 0 to 
10V.  

04 How is the Genie base unit and 
extension modules connected? 
How do they communicate?  

Connect C1 and C2 terminals of base 
modules to respective C1 and C2 
terminals of extension module/s in a 
daisy chain fashion. 
Cable for communication has to be 
twisted pair.   



05 Which special function 
elements are supported? 

At present there are 16 Timers, 16 
counters(retentive selectable), 16 
Compare counter blocks, 16 Time 
switch, 12 Analog comparators(with 
DC model)    

06 How can the coil be used as a 
remote/pulse relay? 
 
 
 
What are the various usage 
modes of coil? 

The remote/pulse relay switches on 
the coil when the pulse is received 
and resets it on the next pulse. Coil 
can be chosen as remote relay 
represented by IQ while entering the 
diagram line. 
The coil can be used as normal coil. 
(-[Q1), the remote relay IQ or 
set/reset SQ/SR coil.    

07 What is Auxiliary relay and how 
can it be used?  

Auxiliary relay is a software flag to 
save or forward a state in the ladder 
program. 
The Auxiliary relay (M) can be used 
as a normal coil (-[M1), a remote 
relay IM or Set/Reset (SM/SR) coil. 
32 Auxiliary relays are provided. 

08 Can I use Timers in different 
modes? 

Yes, Timers can be used in 5 
different modes viz. On delay OFF 
delay, Interval/pulse and 
Cyclic/asymmetric ON/OFF modes.   

09 In the Counter and Analog 
Compare functions how to 
select one of the inputs to take 
in absolute value? 

In the Parameter Settings screen fro 
the block press ALT key to select 
input 1 or input 2 to the absolute 
mode. 

10 Can I use Counters as UP or 
DOWN Counters?  
Are they Retentive?  

Selection the direction of counter as 
either UP/DOWN counting. Count can 
be preset from 1 or inputs 2 to the 
absolute mode. 

11 What is the maximum counting 
frequency of the counter block? 

The counter block can accept inputs 
with frequency from 1 Hz to 7 Hz 

12 How is the Clock function 
used? 

Clock function acts like a 
programmable weekly timer,1 Clock 
function block is provided, with 16 
programs per output. 

13 Is the function blocking 
possible on Genie? 

Yes, each function block can be 
locked so that the parameters 
associated with the block cannot be 
changed in the run mode. 
Block by default is unlocked and can 
be locked by moving to the lock 
symbol and pressing the up/down 



arrow key in the block’s parameter 
setting screen. 

14 Can the arrow keys on the 
genie be used as inputs? 

Yes, the four keys (Z1-Z4) can be 
used as inputs. They 
can only be used as contacts within 
the ladder program.  

15 How can I make backlit of LCD 
permanently ON or OFF? 

By default the backlit is in Auto off 
mode. In Auto off mode the backlit 
will go OFF if no key is pressed in 15 
seconds and will come ON if any key 
is pressed. 
You may choose the backlit to be 
either Continuously ON or OFF by 
navigating to the utilities menu on 
genie. 
 

16 What care to take while 
uploading the program from 
genie into PC or PC to genie. 

Refer to the transfer options as 
explained in the manual 
Check if the serial cable is connected 
at the selected COM port in the 
program and port is not in use by any 
other application. 

17 I have USB ports on my 
computer, how do I transfer? 

A USB to serial conversion cable can 
also be ordered now. 

18 What is the memory card used 
for? How is it used? 

You can save the application logic in 
the memory card for future use. It is 
particularly used if user wants to load 
the same application program on 
multiple units quickly. 
Use the Card >Device command on 
the unit to transfer the program. 

19 Can I have a hard copy of the 
application program I have 
written? 

Use print option G-SOFT to take 
printout of the ladder logic. 

20 What resolutions does the G-
SOFT Ver5.x support? 

G-SOFT 5.x works well with 800X600 
and 1024X 768 resolutions. 

21 In G-SOFT Ver5.x I want to 
simulate my program in PC 
with genie itself. How do I do it? 

Select ‘Simulation with device’ in the 
simulation menu in G-SOFT . Now 
PC acts as master in the RUN menu. 

22 How I can get more familiar 
with genie? 

Try yourself the application examples 
given in the user manual where in we 
have tried to cover the use of various 
elements comprehensively. 

23 What to do if I find some 
problem with Genie? 

Kindly contact us immediately for 
solutions. However we recommend 
you to initially go through the details 



provided in the user manual and the 
FAQ. 

 
 
Appendix C Program Error Codes 
 

 


